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OBJECTIVES
¡ Review daily duties of unit-based pharmacists

¡ Recognize the importance of appropriate 
documentation

¡ Relate responsibilities to impact on patient care 



Antibiotics Renal 
Function



AUTOMATIC RENAL 
DOSING OF 
ANTIMICROBIAL 
AGENTS

¡ Assess renal function in last 72 hours

¡ Order Renal Function Panel per protocol, if 
necessary

¡ Urine Output

¡ Renal replacement therapy, if applicablePurpose: Allows pharmacists 
to change the dose and/or 
frequency of antimicrobial 
agents based on adult 
patients’ renal function or 
renal replacement therapy

NOTE:



AUTOMATIC RENAL DOSING OF ANTIMICROBIAL 
AGENTS

1. Assess renal function and renal replacement therapy, if applicable

2. Calculate creatinine clearance and determine regimen

3. Adjust the order

1. For NEW ORDERs: Change dose/frequency and verify

2. For EXISTING ORDERs: Sign as “Standing order: co-sign required” per primary provider

3. If Infectious Disease (ID) is consulted, send FYI page to ID specialist

4. Document in administration instructions and as an i-Vent

1. “Antimicrobial Stewardship”; “Change dose/frequency”

5. Follow up

1. If renal function UNSTABLE: Re-evaluate renal function or renal replacement therapy daily

2. If renal function STABLE: Close i-Vent after 72 hours



Warfarin Parenteral 
Anticoagulant



VTE-3 CORE MEASURE 
FOR OVERLAP 
THERAPY

¡ Joint Commission Core Measure

¡ New pharmacy to dose warfarin consult for VTE

¡ Pharmacists managing warfarin therapy for VTE will assess 
parenteral anticoagulation overlap

¡ Open a “Core Measure” i-Vent on the parenteral agent

¡ Update i-Vent daily

¡ Place recommendations for overlap in initial warfarin note

Purpose: Patients with acute VTE 
require overlap with a parenteral 
agent while warfarin reaches 
steady state



VTE-3 CORE MEASURE FOR OVERLAP THERAPY

1. Identify warfarin consult for VTE (acute or history) with parenteral 
overlap

2. Open “Core Measure” i-Vent on parenteral agent

1. “Day X of 4 warfarin/parenteral agent overlap” 

1. NOTE: The day that the i-Vent/overlap starts is DAY 0

2. Record current monitoring parameters

1. INR, PT, APTT

3. “For acute DVT/PE diagnosis, recommend at least 5 days of combined parenteral 
anticoagulation and warfarin with an INR greater than or equal to 2 prior to discontinuation of 
parenteral anticoagulation”

1. Also add this statement to the initial warfarin pharmacist progress note 

3. Follow up

1. Update daily while overlapping with parenteral therapy



VTE-3 CORE MEASURE 
FOR OVERLAP 
THERAPY

If parenteral agent discontinued, 
document the same day and 
contact prescriber, as necessary, IF:

1. Overlap is < 4 days

2. Overlap > 4 days but INR <2

“.pharmacyoverlapanticoagulationnote” 



Warfarin DOACs



ANTICOAGULATION 
PATIENT EDUCATION

¡ Ensure patients can successfully utilize anticoagulants safely and 
efficaciously

¡ Timeframe: Education and documentation within 24-48 hours of 
therapy initiation

¡ On ALL oral anticoagulant orders, open “Patient Education” iVent

¡ Use smart phrase “.anticoagedu” to assess the need for patient 
education

¡ Anticoagulant Teaching Service Pager: x52071

¡ Available to page from 1000 to 1500

Purpose: Provide education 
for high-risk medications to 
improve successful outcomes 
as a national patient safety 
goal



ANTICOAGULATION 
PATIENT EDUCATION

Responsibility Warfarin DOACs SmartPhrase

Patient Education i-Vent ✓ ✓ ”.anticoagedu”

Education Required if:

New Start ✓ ✓

Non-Compliance ✓ ✓

Benefit from Education ✓ ✓

Atrial Fibrillation ✓* ✓*

VTE (Acute or history) ✓

Hypercoagulable States ✓

Completed Education:

Patient Education i-Vent ✓ ✓ ”.pharmeducationnote”

Pharmacist Progress Note ✓ ✓ ”.pharmeducationnote”

Patient Education Tab ✓
* If other condition met to require patient education (i.e. new start, non-compliance, etc.)



”.ANTICOAGEDU” Open i-Vent upon order verification 
and use SmartPhrase to evaluate the 
need for education in the ”Patient 
Education” i-Vent 



”.PHARMEDUCATIONNOTE”

Royal Oak Pharmacy - Patient Education

Anita Anticoagulant has received counseling on the appropriate use and potential adverse effects of the following 
medications: Apixaban. The patient has verbalized understanding of the information provided and received literature.

“Patient and family member present for education. Education provided and all questions regarding therapy were 
answered.”

Pharmacist: John Smith, PHARMACIST

Place the following in the ”Patient 
Education” i-Vent and document in a 
“Pharmacist Progress Note”



WARFARIN

“Patient Education” Tab > “Warfarin (Coumadin) Education” > “Document”

Patient Education Documentation

1. I-Vent

2. Pharmacist Progress Note

3. Education “Resolved”



WARFARIN

“File” > “Resolve” > “Education Complete”

Patient Education Documentation

1. I-Vent

2. Pharmacist Progress Note

3. Education “Resolved”



Clozapine

Absolute 
Neutrophil 

Count 
(ANC)



CLOZAPINE REMS
¡ Clozapine (Clozaril) is an atypical antipsychotic 

¡ Used for schizophrenia or schizoaffective disorder

¡ Only available through a risk evaluation and 
mitigation strategy (REMS) program

¡ Mitigate risk of severe neutropenia (ANC ≤ 0.5 bill/L)

¡ Clozapine REMS-certified prescriber must write all 
new prescriptions and enroll patient

Purpose: clozapine can cause 
serious adverse events 
including neutropenia, which 
can lead to severe infections 
and death



¡ Upon order for clozapine, go to: ClozapineREMS.com

¡ Every pharmacist will need their own account:

¡ Select “Need an Account?” > New User > Pharmacy Staff

¡ Zip Code: 48073 NPI: 1356384697

¡ Click on “Pharmacies” tab > “Action” > “Eligibility Check”

¡ Enter patient’s information to verify they are registered with REMS

¡ First Name, Last Name, Date of Birth, Zip Code 

¡ Chart Review > All Reports > Facesheet

¡ At least one provider identifier (DEA or NPI)

¡ NPI can be looked up here: https://npiregistry.cms.hhs.gov/

¡ Alternatively, may call 844-267-8678

https://npiregistry.cms.hhs.gov/


¡ Evaluate and document weekly ANC values

¡ If not ordered, order CBC with differential per protocol and document 
result in “Order/monitor labs/levels” i-Vent

¡ If lab comes back outside of acceptable range, pharmacist must notify and 
receive direction on further dose management and document in i-Vent

¡ Report weekly ANC values to Clozapine REMS Program

¡ Click on “Pharmacies” tab > “Action” > “Add Lab”

¡ Enter patient’s information

¡ First Name, Last Name, Date of Birth, Zip Code 

¡ Chart Review > All Reports > Facesheet

¡ Add Patient Lab

¡ ANC value per microlitre and Blood Draw Date

¡ At least one provider identifier (DEA or NPI)

Epic REMS

5.2 bil/L 5200 per microlitre

“Just move the decimal 3 places to the right!”



Dofetilide Arrhythmia



DOFETILIDE
ADMINISTRATION

¡ Dofetilide (Tikosyn) is used to convert patients with 
atrial fibrillation or atrial flutter to normal sinus 
rhythm (NSR) 

¡ Use requires a minimum of 3 days of inpatient 
monitoring

¡ Creatinine Clearance

¡ Continuous electrocardiographic (ECG) monitoring

¡ Cardiac Resuscitation

¡ Dosing based upon calculated CrCl and QTc

Purpose: minimize the risk of 
induced arrhythmia with 
initiation of dofetilide
infections and death



DOFETILIDE
PHARMACIST 
RESPONSIBILITIES

1. Upon receiving order for dofetilide, place a ”Patient 
Flag” in Epic on the patient’s profile indicating 
“Dofetilide Patient”

2. Open i-Vent to verify and record correct dose based on 
CrCl and verify labs (K+/Mg2+/Ca2+) are within range

3. With each dose, pharmacist should verify that no 
interacting medications have been prescribed and that 
the QTc interval is recorded

4. Pharmacy provides patients with a 7-day supply and 
education is required prior to discharge

1. Patient Flag for Dofetilide

2. Open i-Vent; Verify 
Correct Dose

3. Follow Up on Subsequent 
Doses



Darbepoetin Hemoglobin



DARBEPOETIN REPORT

¡ Darbepoetin is an erythrocyte-stimulating agent

¡ Darbepoetin doses are given at 1700 every Wednesday

¡ Within 48 hours of dose, patient’s hemoglobin must be 
assessed

¡ If no Hgb ordered, order CBC per protocol to assess

¡ For CKD patients NOT ON DIALYSIS or ONCOLOGY patients

¡ Initiation of therapy is permitted if Hgb < 10 g/dL

¡ Hold dose if, within last 48 hours, Hgb ≥ 10 g/dL

¡ For CKD patients ON DIALYSIS (HD, PD, CRRT)

¡ Initiation of therapy is permitted if Hgb < 10 g/dL

¡ Hold dose if, within last 48 hours, Hgb ≥ 11 g/dL

Purpose: Increased risk of 
cardiovascular events in 
patients receiving 
darbepoetin (Aranesp) and 
epoetin alpha (Procrit, 
Epogen)



DARBEPOETIN REPORT ¡ Open “Order/monitor labs/levels” i-Vent for any 
new darbepoetin orders

¡ Copy and paste most recent hemoglobin result for 
patient

¡ Within 48 hours of each Wednesday at 1700 run 
the RO Darbepoetin/HGB Report

¡ My Reports > RO Darbepoetin/HGB Report

¡ For each result, document in the i-Vent the patient’s 
most recent hemoglobin result

¡ If Hgb not within 48 hours of dose due, order CBC per 
protocol and assess result

¡ State “OK to receive darbepoetin dose on MM/DD/YY”



MEDICATION HOLD 
ORDER

If Hgb above acceptable range: 

1. Page physician 

2. State to nurse that patient 
does not qualify for dose

3. Place order to hold dose



IV PO



IV TO PO REPORT

¡ A pharmacist will identify patients receiving parenteral 
formulations of select medications listed below and 
automatically convert them to an approved oral dosage form

Purpose: avoidance of the 
added risks associated with 
continued IV therapy, lower 
overall medication and 
associated costs to the 
patient and the hospital, and 

potentially reduce hospital 
length of stay

Agents Inclusion Exclusion
All 
medications 
on list

• Adult patients
• Adequate oral intake and 

enteral absorption
• Tolerating at least full liquid diet 

or tube feeds
• Receiving other meds PO or per 

tube

• Documentation of NPO status
• Complete bowel rest, pre-operative or 

postoperative fasting
• Active gastrointestinal bleeding
• Nausea/vomiting 
• Conditions that affect gastrointestinal absorption
• Mucositis/esophagitis/stomatitis 
• Dysphagia/risk of aspiration
• Patient refuses oral medication

Anti-
infectives

Above, plus:
• One or more days of parenteral 

therapy
• Stable and/or improving clinical 

status
• Afebrile (all measurements < 

38°C) for >24H WBC count 
normalizing

Above, plus: 
• ICU Patients
• Meningitis, endocarditis, neutropenia, 

osteomyelitis or septic arthritis
• Bacteremia- conversion to oral therapy requires 

approval by physician 
• If the Infectious Disease service is consulted, 

the ID physician needs to approve the change



IV TO PO I-VENTS AND 
REPORT

¡ Open “IV to PO” i-Vent for any IV to PO medication 
orders upon verification

¡ Run IV to PO 2019 under “Search Medication Orders” 
to capture any potential missed i-Vents

¡ Address potential changes when reviewing i-Vents

¡ If patient is eligible for conversion the pharmacist will 
discontinue the IV formulation and change to PO 

¡ The pharmacist will input an I-Vent and a comment in 
the administration instructions noting that a 
conversion per standing order was implemented and 
close i-Vent



IV TO PO I-VENTS AND 
REPORT



PRN PRN



DUPLICATE PRN

¡ Library > Search > “Duplicate PRN” > Run ”Royal 
Oak Rx – Duplicate PRN Reasons” Report

¡ Assess list of your respective floors

¡ Identify any PRN medications with the same PRN 
indication listed and page ordering physician to 
reconcile, as appropriate

¡ Acceptable PRN medications would include:

¡ Linked Orders (L1, L1, L1)

¡ Orders input by respiratory therapists (i.e. albuterol)

¡ Different routes of administration 

¡ Admin instructions differentiate which to be given first





NON-FORMULARY 
MEDICATIONS

¡ Upon receiving an order for a non-formulary medication 
do the following:
¡ Ask yourself (or the provider), ”is it necessary?”

¡ See if the patient has received the medication as an inpatient 
before

¡ Call Central Pharmacy to see if medication is available on the 
non-formulary shelf
¡ If not available, ask if outpatient has or if patient can bring from 

home

¡ Once questions above have been assessed and drug is 
determined to be necessary, call Charge Pharmacist for 
approval
¡ Only to be approved by Charge Pharmacist/Supervisor

¡ If not deemed necessary, page/call provider with 
therapeutic alternative and document in “Therapeutic 
Substitution” i-Vent



NON-FORMULARY 
MEDICATIONS

¡ If approved, place new order for medication

¡ May require database lookup

¡ Once verified the medication needs to be labeled 
with an LOA label (patient supply) or a regular label 
(if hospital supply)

¡ Place i-Vent with approval information, route through 
which drug was obtained, and storage location (if 
kept in 6CN)

¡ Fill out Non-Formulary Drug Request Sheet and Fax



NON-
FORMULARY 
MEDICATIONS



Stroke Core 
Measures



STROKE LIST

¡ Pharmacist receives daily email from Wendy 
Carriveau (Wendy.Carriveau@beaumont.org) and 
Caitlin Woodruff (Caitlin.Woodruff@beaumont.org)

¡ Email contains Stroke List Excel file with the 
different core measures and responsible personnel

¡ For patients already discharged home-UBS 
pharmacist will review the After Visit Summary 
(AVS) to confirm patient was discharged on 
appropriate medications

Purpose: Evaluate 
compliance with Joint 
Commission Core Measures 
for patients with ischemic 
stroke

http://beaumont.org
http://beaumont.org


STROKE CORE MEASURES

¡ STRK 5 – Antiplatelet therapy by end of day 2 (second midnight after admission, NOT 48 hours)

¡ STRK 2 – Discharged on antiplatelet therapy

¡ STRK 6 – Discharged on statin

¡ STRK 3 – Anticoagulant therapy for atrial fibrillation/flutter



STROKE LIST

Fill in daily and email back by 
end of the day



STROKE CORE MEASURES DOCUMENTATION
¡ Open “Core Measure” i-Vent on ”Patient Specific Medication”

¡ Subtype: “Stroke”

¡ Once all measures are met, document in “Pharmacist Progress Note”

¡ UBS Pharmacist Stroke Core Measure Evaluation: 

¡ Patient is currently on the following stroke core measure medications: 

¡ Anti-thrombotic by end of hospital day 2: Yes

¡ Anti-thrombotic: Aspirin 325mg daily

¡ Statin: Pravastatin 20mg every night at bedtime 

¡ Anticoagulation: Not indicated in this patient 

¡ Patient was evaluated to assure core measures were met 

¡ Pharmacist: Les Strokes ext. 89558 





ANTIBIOTIC TIME OUT 
TOOL

¡ Identifies patients on antibiotics initiated within past 48 
to 72 hours 

¡ Open patient lists > Epidemiology (2nd listing) > Select 
respective floor 

¡ Assess antibiotic usage and appropriateness of 
continued therapy for possible interventions

¡ Open “Antimicrobial Stewardship” i-Vent, as necessary

¡ Document assessment through “.abxtot” SmartPhrase

¡ Contact Rachael Fuller, Prakash Shah, or Christy Yost to 
gain access to SmartPhrase

Purpose: De-escalation of 
therapy to avoid resistance 
and unnecessary antibiotic 
use 
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